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Adoption roadmap: towards authentic e-assessment
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Paper equivalent e-Exam using word documents

Make format adjustments to cater for both paper and screen.
Have students type their identification information on the first page.

Use tables where complex layout is required e.g. questions and
responses in designated areas (avoid ‘drawing objects’ to position text.
Graphics because these tend to move unpredictably).

Selected response items - type ‘X’ to select in left column.
Ordering - add sequence labels in left column
Labelling tasks - complete a table or add labels to descriptors.

Use standard fonts (e.g. Times New Roman) to avoid substitution when
placed into e-Exam system.

Use different colour text in areas designated for responses. E.g. Ariel
blue. This allows students to quickly see which questions they have
answered when scrolling up and down the page.




Word documents

Common
hints for
typists.

Replicate the coversheet
used at your institution.

Make adjustments for
typists in a manner that
hand-writers can use the
same paper.

Test the the document in
the e-Exam system to
ensure formatting
appears as desired.

Label
conditions
for typists

Practice Exemizarion Practice Exam - PRACRESR

All students to complete

Venue

aUNIVERSITY Seat®

Exam materials (USB/paper) must Stuéent Number

NOT be removed from the venue. Given Name

Doing so will be considered academic misconduct. Family Name

Remember "File > Save’ often. Shortcut "CTRL §°

USB number*

If the page is too big or too small for your screen please
use View > Zoom > Page width
School of Life, The Universe & Everything
Practice Examination

PRACSB888 Post Paper Example Exam
This paper is for all students.

* as.applicable

Examination Duration: <as long as you like™ minutes

For Exemince

Reading Time: <as long as you like™ minutes Quislian

M

..o applicable.

Table to type
identify info, seat
number, USB
number as

Exam Conditions:

This is a School / Central Based Examination

This is a Closed / Open Book Examination

A paper-based bilingual dictionary is / not permitted.

During reading time ~ No writing / write only on the rough paper provided.

This examination paper will'not be releaseé.

Materials Permitted in The Exam Venue:

All students: No (other) electronic aids/devices are permitted ¢.g. phones, tablets,

pagers, image/audio/video/playback/recording devices, internet connected devices el

Calculators -~ None / University approved only.

Lupigts only exception: | x authorised, fully chargeé laptop. During the exam the

laptop must orly de running the supplied e-Exam System USB stick and supplied

software in its authorised state. No other software or electronic resources are

permittec.

Materials To Be Supplicd To Students:

All: 1 printed copy of exam paper, | page scrap paper. Additional paper for answers

will e proviéec on request.

Typists only: 1 e-Exam System USB stick

Instructions To Students:

Typists only: Please check that this file has been saved to the “*Answers' drive with

your student 1D number prefixed to the start of the file name; for example

12345678 _practice_exam_6pp.coc (if it has not, please do so using ‘File > Save as')

All students:

Please write/type your details in the top right of this page.

MULTIPLE CHOICE QUESTIONS: Total

[1 questions, 1 marks] Please answer all questions.

Indicate your responses in spaces provided by ticking or typing an X.

SHORT ANSWER QUESTIONS:

[10 questions, 14 marks] Please answer all questions.

Hand writers: write your response into the spaces indicated. A scparate answer
booklet will be provided upon request should the neeé arise.

Typists: type your response into the spaces indicated in this document. The response
arcas will expané automatically to accommodate additional text.




Word documents
Question formats

Short answer or essay
length questions

Response area can be defied
using a min-height single cell
table. Using min-height provides
better stability in terms of
layout and pagination. The min-
height can be set to provide an
indication as to the expected
length of the response.

The table will expand if
additional text is entered. Table
borders can be solid, dotted or
hidden as may be appropriate.

Show the mark for each question Place instructions I
for each question

1. What i1s your name? [1 mark]
Please write your answer below this line (example of typing below a regular carriage return).

Type here. .

Pre-format the area where a response will appear such that when
students type a response it should appear in a different colour.

This helps students quickly see which questions they have answered
when scanning up and down the document.

Be sure to provide adequate white space between questions for hand-
writers to respond as well. (Note: placing ‘type here’ is not required).

2. What is the make/manufacturer of your computer? [1 mark]
Please write your response inside the box below. (example of typing into min height box)

Type here...

Table Properties

Table m Column  Cell  Alt Text

Size

Row 1:

Specify height: 12 em | 2| Row heightis: At least a

Options

Allow row to break across pages

Repeat as header row at the top of each page



Word documents
A two column table works

Question formats for typists and hand-

. . . . writers. Several question
Selected response, sorting, matching and diagram labeling. types can be done using

7. Into which drive is the e-Exam response file saved? [1 mark]. this structure.
Response | Please type an x into only one ‘response’ box to indicate your answer.
a) System Indicate how students should respond.
b) eExam E.g single or multiple response.
c) Answers A sorting question can be done by

entering numbers.
5. Please label the parts of the picture shown below. [3 marks]

Adjust diagram to remove text.
Replace with numbered/letter
labels. Use single image or
‘group’ the drawing objects.

Use a two column table with matching
letter labels. Students place their
responses into the right-side column.

Please type your answer into the labels column below.

Part | Labels

a) | Type Min-height rows can be used to
b) provide more space. But do not
c) pad cells with carriage returns!




Paper equivalent using word documents

Question formats: Further examples — matching, labelling, completing a
table or matrix, and extended text response.

Question 5: For the following diagram please provide the names for THE XING in the table below.

Question 2. Match the following host-MOTA| A B encyte
below) ) A | Label goes here. Constructed response question.
Possible descriptions: e ° L (& B | Blue text makes it easier to see which questions have
Y R . ’ o5 ( been answered and which have not!
a) Mauris id mi id orci interdum semper. . \ C | Use minimum row heights to provide plenty of space, but
b) Sed eu neque ut est dignissim fringillg % 3 don't use double carriage returns!
¢) Vivamus in dolor euismod, luctus libg LS et D | Doing so means the layout is less likely to be disrupted.
d) Mauris vehicula eros a viverra pellent S o e £ =
e) Curabitur eu mi at nibh commodo var] | L ooz e |
f) Aenean eget orci porta, malesuada lor } a‘ = - —— 4
. . . . uestion 3.
Please write or type the letter of the descriptions listed = Samuel is 5 years old and attends racing cars 5 days per week. Eamon is 10 years old and rides a superbike
Answer ato f. Terms I Wesehy! Raround the same track. It is not a selected response item so some text will be expected.

1. Paxo gcn In the table below, give two (2) examples of flippant faxadism relevant to his age range (4-6 years), and
X = describe how Samuel and Eamon differ in their abilities to perform faxadism.
II. Sitabosis [4 marks]

1I1. Fwn Two different examples | Describe Samuel’s abilities (age 5) Describe Eamon’s abilities (age 10)
" 2 X of flippant faxadism
Question 7: Some rationales for punishment are XEZTJ| (one per row)

does this mean? Type here Minimum heights set for both rows

(D [{O [i [~

Please write / type your response inside the box below.
The student types their answer here. In this exam More details about setting heights
a two row table. The response table row is create eppeariater In thess examples.
cell has a minimum height set (by dragging the bo
and a minimum height cell instead of successive carriage returns to set the box height, the next
question will be less likely to be disrupted when students type their responses. The initial size of the
box should indicate the desired length of the response. The box will automatically expand when it
gets full.




Word documents

Question formats Place instructions for typists to use drawing

. . tools (note be sure the instructions match
Diagram and drawing responses the e-Exam system software! - see below)

8. Draw your face below using the drawing tools [View > Toolbars > Drawing]. [2 marks].
Please put your answer below this line (you may make more space as required).

Diagrams in the e-Exam system (Libre Office) >
1. In Libre Office Writer: upper right toolbar and select ~*
(or use the top menu bar View > Toolbars > Drawing).
2. The Drawing toolbar will appear at the bottom of the window.

,_&7q-....ALO'G"-'*'-'E"DF%@

2. To draw use tools: Pencil 'Free-form Line' for free hand lines, 'line' tool for straight lines, shape tools to
draw shapes, and 'text box' to type labels.

. To edit an object, select it with " from the drawing tool bar. Then
. Use the 'Properties’ tool bar at the top of the window

v S s ———:]000em ) Qv (Glor jeC— - - EEE

L]

Cy S = = 1= [

]




Paper-equivalent student’s choice -

Macquarie University. Paper equivalent in-class exam. ICT in Education, 80 min
40% Final exam. Word document: 10 x MCQ and 1 x Essay.

Phase 1 ~ toe in the water.

BYO laptop, offline (no network).




Paper equivalent language exam

University of Queensland. French language. 120 min 30%. Article translation and
response essay. LOTE selection during start up 1. Word document with two column
(table) layout to facilitate ease of translation 2. Type English and French using
QWERTY 3 with accents or AZERTY layout.

Please select your LOTE:
Arabic

Chinese

French

Greek

Japanese
Korean

Cancel

§¢| Example:

Text 1
Brief

This French ad for Expédia.fr is targeted at Francophone travellers who want to visit Senegal, West Africa.
The Australian branch of Expedia has asked you to translate the ad copy into English with Australian

travellers in mind.

Source Text 338 words

Accent agiu é: type a
'single quote’ then

type the letter e.

Vacances a destination de : Sénégal

Envie de partir en vacances en Sénégal ? Laissez
Expedia vous guider vers les vacances parfaites, ot
vous pourrez vous détendre et profiter de votre
séjour. Notre page consacrée aux séjours en
Sénégal vous aide & organiser votre séjour et a en
profiter pleinement. Si vous avez déja réservé ou
pensez réserver un voyage en Sénégal, pourquoi ne
pas réserver un hétel avec votre billet d’avion ?
Vous pourrez ainsi réaliser des économies en
profitant des meilleures offres d"Expedia.

Pour planifier votre séjour, utilisez notre carte pour
trouver les principaux sites touristiques a visiter en
Sénégal et vous familiariser avec les environs de
votre hotel. Vous yous y rendez pour la premiére
fois ? Notre page sera un bon point de départ. Vous
pourrez en apprendre plus sur votre destination et
ainsi établir un itinéraire reprenant tous les lieux
que vous souhaitez visiter, y compris les musées,
marchés, magasins, restaurants et bars. Nous avons
également une section dédiée aux attractions
touristiques et lieux d’intérét. Jetez-y un ceil pour
plus d’idées d’activités lors de votre séjour.

Target text — type in the dashed box below.
Holidays in Senegal

...........................................




Paper equivalent language translation exam
NAATI certification at Monash University 2016-2018.

Multiple languages and input methods available. LOTE selected at system start

File Edit View Insert Format Styles Vindow ) (54%)
;—n-m-rf—".-n@r_axm 4 9-C- QA B-PINBE-Q 2880 Hv —e-/
% Default Style I k| R4 i [z B Z U -S| AA|LIR-A-[E-E-|EF ZE|IB B E= 34>
e Passage 2
= Brief
ﬁj The translation of this text is to appear in an academic journal in the field ofeducation in your LOTE. The Eng lish (US)
original is an abstract to the English language version of the academic paper. The audience is teachers and _
b N researchers in tertiary and higher education with an interest in using computers and online tools in |
hers i iary and higher ed i ithan i i ing p d onli Is i Rime
= education. Canaiie
Source 117 words Target LOTE QJ
To type or handwrite: student’s experience across | TR F 5. *Eﬁﬁf(ﬁ‘i%ﬁ;ﬂﬁ#ﬁ_] Chewing
six e-Exam trials BT : New Zhuyin
This paper reports on student's experience of e-Exams as | bo pomo fo (m 1 7n)
collected via surveys undertaken in conjunction with a AR T2 4 (T B L= AR R — RS -
series of optional live trials of an open source, bring- W IRHFZ B3 T AFIT B4 22 k22 7F 2014 £ R A ’ Stroke5
your-own-device (BYOD) based e-Exam system in six AT A 1 gt Xﬂ'j,?: F R T E I | WuBiHaifen g 86
mid-semester undergraduate examinations during 2014 at MRt LR B 8% & i AL Y DABocS R oS
The University of Queensland, Australia. A set of surveys | 7z gzt i1 5 4 §lif47 ) 12 2% 38 a8 55 ¢ 5 “Intelligent Pinyin
were conducted prior and following each exam that ik 5 M. BRI, 2REN. (ZOEE. MEE |
co::r:lzd ease of use, technical is;uesd, comfort, H 3T FEEHEE - R (Likert) & | Character Ma p
confidence, time, typing versus handwriting prowess. ERTHA BRI T EF M E SR AL AR S - &
Responses to Likert items were compared between those LT B IERRS 24 T S A A A R, *iR | Keyboa rd Layout Chart
students who elected to type and those that handwrote SEHET B AR 2 B+ 40 Bl - ’ Text En tfy Settin gs
their exam. Insights as tan which issues nroved significant [ -
all R SEE FE CBE BE- T+l B-70-5-O-%$%0e Au 8- L f B
— Page 4 of 6 1 words, 1 characters selected Default Style Chinese (simplified) I. &8 Table5:B2 0 - jo- +  163%



Towards ‘post-paper’ (phases 1 to 2)

Start simple and build up! e e

SAM_O232.AVI « VLC media player

Start! Exam doc Video [ te

Please select your LOTE: -
Arabic ® 4B & TSavh o a FE=R 2K
Chinese O E A4l SE a8
French e TS T TS [ WO T BTN PR T IR YT SRS —
o ot e ey s e B Ao < vy S s nad b b e it g
Greek e Sampie answer goos heve umn‘u rosponses appear in blue Anel lext
Japanese ﬁ Qeowsan 3. (1 mark|: Where should s clisam ropoass file b sved? =
Korean ~ [_Response | Menw how a1 1 ik oy orw ieaponee Sou b exicals your anemer
- 3) Spnten
oy e::&m e >y i
1 G) Arswers — - oo
Cancel OK
Question 4. 1 mark ] Which is the ‘onc-time boot key” for your compuns ==
Phemen ey mtew Jekoe P hw

Quoson 8. |2 marka} The following diagran has some smdestifiod parts mdicatod by part mermbers

Spreadsheets as ‘forms’ or
as calculation and analysis.

Scratch SDK

lls\ 4 TshChomp. Scratch
GCHR =S = I

o) ” tungry fnh S apert Ygwite
[o] rs demiton

vedle MM Eeeder WAL Mol fee

§ cro |
»IBA000 4N0QOKHE 100K

PDF

Sims




Word documents

Post-paper features can include multimedia and additional software tools.

Recommended: Use embedded links within the document to point to media resources or software
tools (when these are ‘portable’ apps). Do not place multimedia objects directly into the

document because these tend to break.

Links must be ‘relative’
within the e-Exam USB.
See example hyperlink
below.

Provide instructions for alternative
access e.g. Students can find the
resource using the File manager.

9. View the video file by clicking on this link, or double-click on the file Genomics Digital Lab.ogg in the
wMaterials folder. [2 marks].
[ 1 .1 .1

N o™ 1 1

o 1 N 11 1 +1 1. 1 0

10. Open the CelestiaPortable application file by clicking on this link or go to the Materials/CelestiaPortable
folder and open CelestiaPortable.exe. After the softwar~ - a planet appears on the screen. Write the

name of the planet you see belo : :
Please put your answer below this line Edit Hyperfink -

Type here' . Link to: “ﬁrlre:/llqgalhost/mn;/eexamlMa;eﬁajs/Cglestianrtable/CglgstiaPortablg.exg <

Display: this link



Word documents

Mathematics example. Use third party software to answer questions. In the case of
installed applications users will need to locate the software via the launcher.

Provide instructions to access the

3. Scilab will be required for the following question. software.

To open this application, click on the circular icon on the top left of the screen, and then type

‘Scilab’ into the search box that appears. :
Provide space for responses - these
_ _ can potentially be copy-pasted from
What are the results of the following Scilab program? [1 mark] the other software.

Please put your response inside the box below.

Use this program:

function f = myquadratic2arg ( x1 , x2 )

£ = XIXN2 + X2HX27

endfunction

Xdata = linspace ( =1 ,; 1 ; 100 );

ydata = linspace ( -1 , 1 , 100 );

contour ( xdata , ydata , myquadratic2arg , 10)

How do you interpret this chart?




File Edit ?
Ba® £ @

B @ §

B] == (95%) 4) 12:33AM

Graphic window number 0

@Y @

ow number 0

The output of
the software -
in this case a
chart. This can
be copy-pasted
back to the
"~ word document.

L1.45

File Browser ? 2 X Scilab 5.5.2 Console 2?2 Variable Browser
B /home/ubun | + || & — - Na... |Value|Type \/isi.;J
Name 7 A Tgasipnexiﬁl;ti:?environment e (ydata | 1x100| Dou..[ local
= 9 et [xdata | 1x100| Dou...| local
» ; . -->function f = myquadratic2arg ( x1 , x2 )
ﬁb i s> o= x1RR2 4+ x2%%2;
B Di(s:uncﬁ)Fe)nts - ->endfunction
EP‘O\;‘{?loads -->xdata = linspace ( -1, 1, 100 );
usi
E}Eicﬁl{_}res -->ydata = linspace ( -1 , 1, 100 );
ublic
& Templates -->contour ( xdata , ydata , myquadratic2arg , 10)
[& Videos
i Command History 22 x]
F=x1**2+x2*;;; =
Student uses endfunction ]
xdata=linspace (-1,1,1
SOftware tOOl to ydata=linspace (-1,1,1
contour (xdata, ydata, r
explo re and v //--07/02/2018 00:29:57 --
function F= myquadratic/|=
construct a F= X942 + X2¥%2;
endfunction
response. xdata=linspace (-1,1,1
v ydata=linspace (-1,1,1
B Casesensivel ] : contour(xcjata, ydata,’r =
|
| = e i
endfunction
xdata = linspace ( -1 , 1 , 100 );
data = linspace ( -1 1l 100 );
’ ’
contour ( xdata , ydata , myquadratic2arg , 10)
How do you interpret this chart?

Provide space for responses in the
word document. i.e. the student
can paste the chart here!

| The chart shows that I | &

=

B 1

Default Style

S B E B B

1,057 words, 6,084 characters

Page 2 of 4

=

English (Australia)

$

L fx

Table6:B1

% 00 @ B

1E

=

+ | 183%



Mathematics and other applications

Scilab

QA S B-DNFE B
Arial wjil12 | =B 7 U SR T

il

le Browser ? 2 X Scilab5.5.2 Console

Mi&  /home/ubuntu/ v|®
1 Startup execution:

loading 1nmitial en

Exam -~
[ cbuntu 5 =
1 & o2 funchion {2 wyies B KA OO be required for the following question.
& Desktop -->f = x1%92 + x24%23 Graphic window number 0 —
2 - ->endfunction

& Documents B 3 2 . y
application, click on the circular icon on the top left of the screen, and then type * Scilab’

B3 Downloads -->xdata = linspace { 1

. B Music YA T ) th box that appears.
Sta rter f] les, B Pictures -->ydata = linspace ( lih e, 1;?3
E?uu‘cl i i e NN results ofklhlc ,t:oll,?\;ving Scilab program? [1 mark]
emplates - - 1/ / \ se inside the box below
Code, B Videos Feontour b \ < r"cunc’iru:::lurz { )
frameworks, T {3 33
S nsit Regul 5 da sadre ) e

spreadsheets or & |

Workspace R {
large data sets 7 :

. Name Class

can be provided :

ans double
for an a lyS] S Eoys :g:g:: How do you interpret this chart? The graphic shows...

* X double o
ri l pl
Command History ‘ . FEBREE BEE B E BEE B T+1L®B-7 0 =-0° % Multiple
E) 2 ° 7 L R v S B - 1 v - = . 3 <4 . .
Filter [d] T» / r': Page 20f 4 1,060 words, 6,139 characters Default Style = English (Australia) I.| @& Tables:B2 [ o + | 109% appllcatlons
A=|345; inpu (-0.53518, 1.85926) | e ‘
o5 M. . | rat: replaced -0.01666666666666666 by -1/60 = -0.01666666666666666 can be Used
x=A\b i o PG rat: replaced 0.03 by 3/100 = 0.03
corr(boys(:.2), boys(:3)) > | rat: replaced 4.933125 by 7893/1600 = 4.933125 together.
command Window  Editor Documentation rat: replaced 66.18338133333335 by 3102346/46875 = 66.18338133333333
L (%03) 61.25025633333333

Candidates can access wxMaxima, SciLab, GeoGebra, GNU Octave (like MatLab), R (statistics
package) to interrogate questions. Data sets can be provided for analysis.

A standard LibreOffice suite (word processor, spread sheet etc), media, plus programming tools such
as Python, Scratch can also be made available as separate modules.

Responses can be made via world document or Moodle LMS.




Spread sheet as a Form

Monash University 2017
Phase 2.5!

A form - but with no network.
Multiple components:

1) Student XLS file (contains

8 questions and response fields - given to

students).

2) Collation utility (to merge student

response files into single marking file.
Not given to students).

3) Marking XLS file (contains

assessment logic and answers. Not given
to students).



Spread sheet as a Form
@ T | anguage tools available .m S ——

ErEE e Rl according to LOTE selection Rime
NotosanscJKsCi|v| (12 |v| B 7 U - Ty - | = Cangjie

€59 [v] fx X v [tr$F B Chewing
A B D E ] F G H |

77 New Zhuyin

Rewrite:
bopomofo (m17n)

Stroke5
WuBiHaifeng86
% Intelligent Pinyin

@ MW B W Bk "BE JEE B i Character Map

Rewrite (REF Keyboard Layout Chart

haol Text Entry Settings...
English: I1ﬂ 282 3.8 4% 58 £ O

English:

G i & Respond in designated cells
Sl , (other cells are locked). —r

e I Exam | Instructions
Sheet 1 of 2 PageStyle_Exam 1 Average:; Sum: 0




e-Exam Trial - Chinese language (Monash 2017)

2017 example : 1t year Introduction to Chinese - 1hr, 16% in-class test.
73 students enrolled; 16 typed and 57 handwrote.

“l would recommend the
e-Exam system to others”:

Strongly Disagree Neutral Agree Strongly
Disagree Agree




Feedback - Selected 2017 trials. Those that typed the exam:
“l would recommend the e-Exam system to others”

Strongly agree 5-—
Agree 4- F T l F T !
Neutral 3

Disagree 2-—

Strongly Disagree 1-

I I 1 | | |

Monash: Monash: uQ: Monash: Monash: uQ:

APG5048 APGS5690 FREN3310 ATS1002 APGS5048 FREN3113

Advanced Applied French Chinese Language French

Translation Translation Language lan uag7e S1Translation Language B \
S2 2016 S1 2017 Translation S2 2017 S2 2017

mock exam S1 2017

N 15 30 15 16 22 6
Mean 4.6 4.4 4.1 4.2 4.3 4.5
SD 0.6 0.6 0.8 0.7 0.7 0.8




Post-paper e-Exams with media and apps
Word document question and response space — links to e-tools

University of Tasmania. ICT in Education. Final exam 47%, 2 hours. ""‘%’ X e ':«-; 3 .’.'}’ - \ S
Word doc with short and long text. Constructed response tasks. -' :

Critique student
understanding (video)

Multimedia video prompts.

Solve a problem in
Scratch (block
programming for
primary school students)

(N o it e | a0
! a :
. A
- :
~ E= - .
— @ Chemistry education
r—‘ .
g | e | i) software evaluation

_..== ¥ Scratch programming task




Example Media (video) prompt: Critique student understa

Teaching Secondary Mathematics. Example question:
Comment on the child’s understanding of symmetry based on
her response to this task.

y




Solve a problem in Scratch

Digital Technologies Education
Write a program in Scratch using Felix the cat and a blank stage that:

a) Allows Felix to be moved by pressing arrow keys
on the keyboard

b) Allows the user to draw a picture of a house as
they move Felix around the stage.

when right arrow  key pressed

gideeser_«; ISl 172 BTA 109

le;)eat untdl key down arrow pressed?

gwees«stox 174 BVR - 100

repeat tmti key left arrow pressed?

glide © secs to x: GTDY v: GED

l'epea until  key up arrow

glide @ secs to x: &I v: €D




Programming e-Exam

Edith Cowan University. Teaching Python Programming exam.
Offline word document + Python IDLE

Q1: |Sequence, user input, output| 5 points

A painter requires a program to calculate the number of litres of paint needed for a jod. Ore
litre of paint will cover 16 square metres. The program should accept the number of square
metres to paint and then output the number of litres of paint required to the user.

Write a commented Python program for this task.
Open IDLE Python cnvironment.
Remember to save all files (g /mot/answers/

Q2 |looping] 5 points
A program is required that receives input of five surnames one by one and then prints out the
surnames sorted alphabetically.

a) Draw a flowchart to represent the algorithm for your program [3 points]

*  You can use the drawing tools within this word processor. Make some extra space
here, draw the diagram and save this file (it will be submitted on the USB stick).
ur

¢ Use a separate piece of paper labelled with your student 1D to éraw the diagram.

b) Write a Pythor program for this problem [2 points]

Q3 |write a text file] 5 points
A program is needed to store a list of tools and their hire rate in dollars per day. Write a
Python program to accept data from the user and store it in a text file.

Possible Data:

Air compressor: S45 per day
Tile cutter: $25 per day
Brick Saw: S110 per day
Nail gur $40 per éay

Q4 |read a text file, use a function] 5 points

2) Adé to your program in Q3 so that it can retrieve the name of the tools and the cost per day
from the text file [3 points].

1) Display the data reaé from the file on the screen: make *displayData’ a function in your
program [2 points].

QS |Everything| 10 points
Create a robust, modular, user-fricndly, & commented Python program to simulate an
automatic teller machine. The program should:

a) Set up the accounts for 3 people and store their four-digit pin number and their initial
halance in a text file. [3 points]

b) Allow a user to login using their pin [1 point]

c) Allow a user to see the balance of their account [2 points]

€) Allow a user to deposit and withdraw morey [4 points]

End of Exam
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##- - //Assessment+1.2:-In-Class-Test—

- DR Question #3:-&-4-
- DR Author: - SRBHIRAE-

##--//Create-text-file:-to-store-tools

def-displayData():-
«++-print(a.read())-
a'=-open("tools_sheet.txt", ‘"w"}-

##- - //Receive-user-input-of:tools-and
tooll:=-input("Please-enter-the-first
pricel-=-input("Please-enter-the-hire
print- (tooll, ":-",-pricel, file=a)-

-and-hire-rate-

-hire-rate-
‘tool-tool-needed: -")-
rate::")-

tool2:=-input("Please-enter the:second-tool-tool:needed: ")~

price2-=-input("Please-enter-the-hire
print-(tool2, ":-", price2, -file=a)-

too13-=-input("Please-enter-the-third
price3-=-input("Please-enter-the-hire
print-(tool3, ":-", -price3, -file=a)-~

‘rate:-")-

‘tool-tool-needed: "}~
-rate:-")-

tool4:=-input("Please-enter:the- fourth-tool-tool-needed: ")~

priced4-=-input("Please-enter-the-hire
print-(tool4, ":-", priced, file=a)-

a.close( )~

##- - //Start-of -Question:#4-
##--//Retrieve -data- from-Question #3-
a-=-open("tools_sheet.txt",  -"r"}-

‘rate:-")-

print("diplaying-contents-of:text-file")-

displayData()-
a.close()-
##--//Display-data-from-text-file:(in

-

-IDLE-Shell-enter: 'displayData() '~




Robust Moodle

Monash University 2018. Chinese language — two
units (1t year and 39 Year). Listening test.

Moodle quiz question/response medium Selected
3" party software included.

Robust Moodle worked to rescue network
outages (double layered backup!).

nr -

Audi’o data files cached at the

start of the exam.
Students used headsets to
listen. Responses via Moodle.

Question 5

Section 3
Not yet answered
Indicate the tones you hear.
Marked out of
24.00 Please enter a number for the tone you hear in the app
¥ Flagquestion & 4 chuang lian
£ Edit question

e 2.cao chang

e 3. fang xiang

® 4. guo jia



Third party software included

Start e-Exam Demo

LMS
questions in
Safe Exam
Browser

¥ AQVANCEea SWOeNts: piease ransiale any (wo ol Ine 1onowing Lninese
passages into English.
w You will be marked against criteria specific to your proficiency level.

You may use Dim Sum Chinese tools for this question. To open the software
from the e-Exam System - use the circular 'Dash’ button at the top left of the
screen. The type “dimsum" into the search box.

Below are three separate Chinese source lext passages - please scroll 1o
read them.

Passage 1

Be sure to look at the notes associated with the bolded red vocabulary items,
as these words cannot be found in DimSum.

BMBMARMB— T AQER, 20155, RAEFOE 15-64¥ N hEAFHFEHA
Q&2 A0M73%, Bl 210.03(Z, Bl2020%%459.851Z, BI20304%479.521Z,
B T2050% EH8IZ 5 . 0E, REFHFERAOSLAOLERE6%, M2
67%, BARR61%. N, RERXERFHERAQLURINT.IMZ, BRSO~ H
FNEFBEEN®GS . LR, FEFARINEFRFHNIME, LUSHHRK
TERT, EARSBANEEIINE FrNN B E TR C)HE

Notes:

O kéujing = 4.8
THTRBEEIEPMRNERARNNS

Type your translation(s) below. Please indicate the passage number(s) for
your selected passage(s).

File

SpIEdYSe]] AJRUOIDIQ JOIRIOULY aSAUIYD

Edit Tools Format Programs Help

DeadXboanRM

Web Address Go Settings
HERATNMB-TFAQESN, 2015%F, FREGOE 15-6420PH
FREMADSSADNTIN, MER10.03Z, PI2020FFEH.85

Z, H2030EEN9.52(Z, HT2050F RS, NE, RMPHE
BADSSBAI ., ~ T%, BER61%. L, BR

pamusi LA BRCHA HHEA KR
N\i8E. M| o !'}?N)Z’H‘Jﬁﬂ. LUSHB KR

XRT, Eh| = Caticiad g ES A0

This is an offline
dictionary tool
‘Dim Sum’

4



Student Findings - Post exam survey (final 34 exam in
sequence) - Monash 2018 - BYOD Robust e-Exams (Moodle)

My hand writing is neat My typing is fast enough for exams

[Post3] My hand- [Post3] My typing
writing is normally skills are fast enough
and for a computerised
exam

W Strongly Disagree

Disag?ee . B strongly Disagree
[ENeutral [ Disagree
EAgree ENeutral

B Agree

M Strongly Agree
SRS M Strongly Agree




Student Findings Pre and post survey (Moodle 2018)

Strongly Disagree

Written instructions were easy to follow

It was easy to start my computer using the e-Exam USB stick

| can use the e-Exam system just as well as my own laptop system

It was easy to use the office suite (word processor/spread sheet)

It was easy to use software applications beyond the word processor

It was easy to save my response files into the correct place

It was easy to answer multiple-choice questions in the e-Exam system
Overall, | feel the e-Exam System is easy to use

| feel the e-Exam System is reliable against technical failures

| feel the e-Exam System is secure against cheating

| now feel relaxed about using the e-Exam system for my exam

| would recommend the e-Exam System to others

My laptop is reliable for use in a computerised exam

My typing skills are fast enough for a computerised exam
Computerised exams make me more stressed than handwritten exams
| would like to use a computer for exams in the future

| am concerned about network outages impact ing my exam

| am reassured the e-Exam system was robust against network outages
The included software was useful [e.g DimSum]

Moodle worked well as an exam environment

—

2 3 4

VTN

Caveat: Not random samples - descriptive of these groups only.

5 Strongly Agree

121
122
120
102

75

68
101
122
121
122
122
122
125
124
125
123
126
125
124
126

® Pre

Post 1

¥ Post 2

H Post 3




Student Findings - 3"4 exam (final)

Moodle worked well for exams Can use as well as own laptop OS

[Post3] | can use the
e-Exam system just
as well as my own
laptop system
M Strongly Disagree

Episagree
ENeutral

B Agree

M Strongly Agree

[Post3] Moodle
worked well as an
exam environment

W strongly Disagree
Disagree

ENeutral

EAgree

B sStrongly Agree




Some Key Findings - BYOD Robust e-Exam Moodle

a) The e-Exam system was rated well by the typists:
4+ out of 5 (strongly agree)

b) Robust network features worked (at least two obvious WiFi
outages):

Responses were auto saved to USB, retrieved following exam and
re-joined the e-workflow in Moodle. No Lost work! No interruptions!

c) Time saved in marking essay responses: 20% to 30% over that of
paper responses.

d) Students need transition opportunity: from earlier exams ~ pre
2015 roughly 30% preferred paper - Must help all stakeholders adopt
e-Exams!




Case studies

More information and mini cases at
http://transformingexams.com

Contact: | =
Mathew Hillier iy ——
http://mathewhillie.com “ "
m.hillier@unsw.edu.au




